
Formatting Footnotes
PagePlus has had footnotes/endnotes since version 10, and the

latest version is not much different here so these tips should work in
all recent versions, though some dialogues may be different.

Shortcuts
If you’re working on documents

with lots of notes, the first thing
you need is a shortcut to insert
them. The Insert key is reserved so
I have assigned Ctrl+Alt+Insert.

� From the Tools menu, select
Options, User Interface,
Keyboard and create a new
shortcut profile if you don’t
already have one.

� In the Menus and Toolbars context (the default), type “footnote”
in the filter field to find the command “Insert Footnote.”

� Click in the “Press new shortcut” field, and press the shortcut that
you want to assign to inserting notes. Click on “Assign” to add the
shortcut. The field below the new shortcut field will warn you if it
is already assigned to some other function.

Next, we want a shortcut for editing notes. There is already a
shortcut to open WritePlus (Control E), but not one to close it, so let’s
add one now.

� From the Context drop list, select the WritePlus context, and click
on the [+] icon to expand the File menu branch. Select “Close” and
assign the shortcut Control E to close WritePlus. Now you can
quickly toggle between PagePlus and WritePlus.

� WritePlus has its own context, so let’s assign the same shortcut to
insert notes here too. Find and select the Insert Footnote
command and assign the same shortcut in the WritePlus context.

OK to close the Shortcut dialogue and Yes to save the changes you
have made. Now that you know the method you can assign any other
shortcuts you might need in PagePlus or WritePlus.

Number Format
The default number format for Footnotes is Arabic, i.e. 1, 2, 3, etc.,

and for Endnotes it is lowercase Roman, i, ii, iii, etc. The drop list
offers a choice of Arabic, upper or lowercase Roman, upper or
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lowercase alpha (a, b, c,), symbols (*, †, ‡, §, ¶), one (01, 02, 03) or
two leading zeros (001, 002, 003), and custom format.

In <custom format> you can add a string of letters or symbols to
use for note numbers, e.g. you might want to use lowercase Greek
letters. Insert the entire list that you wish to use into the text using
the Insert Symbol dialogue (Ctrl Shift S) or if they are not easy to type

— like εζηθικλμνξοπρςτυφχψω — then cut and paste them to the
number format field in the Footnote Options dialogue. If the full set of
symbols is used in a story, the numbering will restart with doubled
symbols: αα, ββ, γγ, etc., which also happens when using the preset
symbols (*, †, ‡, §, ¶).

Whatever custom footnote number format you use will be
remembered by the dialogue to use in other documents. It can only
remember one set of custom symbols, and will show that same list
even in a document where you previously used a different set.

Start At
The starting number for footnotes or endnotes can be changed

from 1 to whatever number you want, e.g. for the next chapter of a
book if you are using BookPlus. (I recommend using only one
publication even for very long books, and this is one reason why).

Restart Every
By default, footnotes restart on every page, and endnotes restart

only for each story. There is no option to restart notes only once for
the entire publication. For this reason, do not split chapters into
separate stories, unless you want to restart the footnote numbering
for each chapter. Otherwise, you will have to use “Start At” for each
chapter, and remember to update it if you add or remove notes
from earlier chapters.

Note Position
There are only two options for note position: Bottom of Column,1

or End of Story.2 In a standard text frame with a single column the
notes will span the width of entire text frame.3 In a text frame with
multiple columns, the notes will appear at the bottom of each column,
spanning only that column. It’s not possible to have all notes for both
columns spanning the entire width of the text frame.

1 Footnotes are collected at the Bottom of each column. 2 Use for Endnotes.
3 By default, footnotes span the entire width of the text
frame. The only way to prevent that is to edit the paragraph
formatting for that note to indent it from the right.
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Separators
The default separator is a 2"

long, 1 point line beneath the
text and before the footnote. To
ensure that the line spans the
entire text frame use any value
greater than the width of the text
frame. A line of 6" will always
span a text frame on A5 pages.4

To avoid the line clashing with
descenders in the last line of text,
you might like to allow 1 or 2 pts
Gap before the notes. To avoid
the superscript note reference
clashing with the line, use a Gap
after the line.

The Gap between notes is
usually zero, but a small gap
here may be useful if a lot of the
notes are long. If you want to
have more than one note on a
line, use a negative gap here, as
in this document, equal to the
size of the footnote font (8 pt).
The notes will then overlay each
other and will need to be

separated manually with indents
or paragraph breaks. For details,
see “Footnotes in Columns,” on
the following pages.

To change the weight, style,
or colour of the separate line,
open the line style dialogue. For
no line, just clear the checkbox
for Line before notes.5

Reference Style
The reference style is used for

the note anchor in the body of
your document and in the note
for the footnote/endnote number.
The default is a superscript based
on the current paragraph font. If
the font has OpenType feature
for superscripts it is used by
default.

Ordinary superscripts are
65% of the point size and are
raised to just above the top of
capitals (T1).

I prefer footnote references
to be slightly bigger, (T1) and
slightly higher to stand out more
from punctuation in the text. So
let’s learn how to modify the
footnote reference style.

4 If the text frame has columns, the 6"
line will only span the full width of the
column in which the footnote appears.

5 The same line style will be used for
footnotes throughout the publication. I
prefer to use a lighter line of 0.5 pt.

Formatted superscripts are lighter
than true superscripts (left)

I¹I1
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� Press your new shortcut (e.g. Ctrl+Alt+Insert) to bring up the
Footnote/Endnote dialogue.

� Click on “Reference Style”, and select the “Font” tab on the dialogue.

� If the body text is 10 point, the default superscript will be 6.5 point,
but let’s increase that to 7.5 points.

� Turn off the superscript, by selecting Position, None.

� Now select the “Spacing” tab on the dialogue, and Position, Raised,
by 3 points. Adjust this value to suit the size and style of your
body text. It now looks like this T1 instead of this T1.

You may notice that the line-spacing of the body text has changed
after you insert a footnote. To stop this happening, edit the body text
paragraph style. Open the “Text Styles” studio tab on the left of the
work space, click on the arrow next to “Body Text” and select “Modify
Body Text…” On the Spacing tab of the paragraph format dialogue,
clear the checkbox that says “Allow for text advances.”

Body Style
The body text style for footnotes is usually one or two points

smaller than the Body Text style for the story. Click the Body Style
button on the Footnotes or Endnotes tab to open the Text Style
palette, where the style can be modified. By default, footnotes use a
paragraph style named “Footnote Text,” and Endnotes use a style
named “Endnotes Text.”

I added a button to my toolbars for “Update
Text Style.” To modify any paragraph style, I just
insert the text cursor in that paragraph, change
the font size, style, etc., and click the button.

See my tutorial on Customising PagePlus for more tips on
configuring the workspace, menus, toolbars, and keyboard shortcuts
to make your work-flow more efficient.

Modifying Footnote Options
At any time, when editing the story, the footnote options can be

modified for the entire story. From the Insert menu, Insert Footnote/
Endnote, or use the shortcut added earlier (e.g. Ctrl+Alt+Insert).

After making the desired changes to the footnote options, click
“Close” on the dialogue (or “Insert” if you want to add another note),
and the modifications will be applied throughout the story.

http://www.softerviews.org/Customising%20PagePlus.pdf
http://www.youtube.com/watch?feature=player_embedded&v=G_n2w9yDUO4
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Editing Footnotes
Although you can edit footnotes directly in PagePlus you may find

it easier in WritePlus. Select a word or two next to the footnote, and
press the Control E shortcut to open WritePlus. Click on the notes
pane icon  to show/hide the footnotes at the bottom of the WritePlus
window. In WritePlus, notes are numbered sequentially throughout
the document, so the numbers may not match those shown in the
document if you use the default footnote option to restart numbering
on each page. This is necessary to avoid ambiguity as there may be
several pages in the document, each with notes 1, 2, 3, etc., but in
WritePlus there are no pages, just one long story.

Cross-references to Footnotes
Insert menu, Information, Cross-

reference, Type: Footnote or
endnote Item: select the footnote
from the list. To insert just the note
number, select Text number (no
context). Disable the Hyperlink if you
don’t want it.  Select the inserted
cross-reference in the text, and
apply Footnote Reference character
style to make it a superscript.

Footnotes in Columns
PagePlus will place footnotes at the bottom of each column and

adjust the spacing set aside for notes depending on the number and
length of notes in each column. However, how can we create multiple
columns of notes below a standard single column text page? This
question sometimes crops up when authors are writing technical
documents with lots of short references because nearly half the page
is wasted if there are a lot of short footnotes, one beneath the other
in the footnote area.

No program that I know of can handle this kind of layout
automatically,6 but there is a viable workaround.7 It is essential to
complete all editing, and finalise the text styles, before manually
formatting each page of notes from the beginning of the document.
The footnotes for this A5 publication are arranged in four columns.8
An A4 publication9 could fit six columns,10

6 InDesign’s Span Columns feature lets footnotes span columns in a multi-column
frame, but I don’t think even its split columns feature will create a layout like this one.
7 YMMV 8 Tabs: 1.21” steps. 9 11.69” x 8.27” 10 7.27” wide page.

http://www.softerviews.org/Customising%20PagePlus.pdf
http://www.youtube.com/watch?feature=player_embedded&v=G_n2w9yDUO4
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� Press your shortcut key to bring up the Footnote/Endnote dialogue.

� Click on “Body Style…” to set the font size and paragraph
formatting for the footnote text. The font size can be one or two
point sizes smaller than the body text — I have used 8 point
footnotes with 10 point body text.

� On the paragraph spacing tab for the Footnote text Body Style, set
the line spacing to Exactly to get the exact line-spacing for the
current font — 9.728 points for 8 point Verdana, but see  note 7 on
page 5. Copy this value, and either leave the line-spacing at
exactly 9.728 points or reset it to single line spacing.

� Click on “Separator” to define the separator line at the bottom of
the page. Since we want to use the entire text frame width for
notes, let’s set the line length to a value greater than the text
frame width. For an A5 portrait page, 6" will be adequate. Let’s set
the line style weight to 0.5 point and add 6 points of spacing after
the line. Set the gap between notes to -8 points, so that the next
note will overlay the current note. Click OK to accept the separator
line and spacing.

� Click on “Insert” to insert a footnote at the bottom of the text
frame using this Footnote Text style.11

� Display the Ruler from the View menu, and drag a tab to the
horizontal centre of the text frame. This is easy as the selection
handle will indicate the centre. Drag two more tabs to the quarter
and three quarter positions. You can do this by eye, or use Format,
Tabs to set them precisely. This text frame is 4.846" wide,12 so I
set tabs at 2.423", 1.212"13, and 3.635".14

� From the Format menu, select “Update Text Style” to add the new
tab settings to the Footnote Text paragraph style.

When we have finished all text editing and formatting we can start
working through the document from the beginning to perfect the
layout — adjusting tracking15 to squeeze widowed lines of text onto
the previous page, etc.

On each page where there is more than one
note, the other notes will be on top of note 1.
Place the cursor in the stack of notes, and click the Increase Level
button on the context-sensitive toolbar. With luck, note four will move
first. Indent it to the third tab stop. Indent the remaining notes. If the

11 8 pt footnote text 12 See transform tab.13 Width ÷ 4. 14 W x 3/4
15 Ctrl+Alt+Hyphen or Ctrl+Alt+Numpad minus.
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wrong note moves at the first attempt, try again and increase the
indent to move another one. With a little trial and error, you will soon
get the notes in the right order. Inserting notes later16 is also possible,
but you might need to rearrange the notes afterwards.

If some notes are long,17 insert a paragraph break at the end of
the preceding note so that the next note starts on a new blank line.
To mix long and short notes, Format the long note’s paragraph to
indent it from the right.18

This method is surprisingly flexible compared to previous methods
I have tried, such as inserting notes in independent text frames. You
may find it easier to indent notes as you insert them, so that you can
still read them while editing the document. It is not difficult to change
the indentation later by using the Decrease Level and Increase Level
buttons on the context toolbar.

There is no option to have notes immediately follow the text.
Resize the last frame in the story or chapter to move the notes up to
just below the text.19

As long as you fully completed the text editing before turning your
attention to the page layout, it doesn’t take long to work through a
two hundred page book, tightening the tracking to remove widows
and orphans, and neatly formatting the notes as you go.

Formatting footnotes in columns is not a common requirement,
and I imagine that designing an option to do it automatically would be
difficult. Sometimes, one just has to accept that a manual tweaking
of each page is the only way to get the best results.20

16 Inserted later.
17 Even if some footnotes are long, add a paragraph break at the end of the preceding
note so that the next note starts on the line below. 18 Following note.
19 This is already on the wish-list for PagePlus X8. In fact, it has been on the wish-list
for some time, but it hasn’t made it to the top of the list yet, because there is a simple
workaround. 20 Hand-crafted furniture is better than flat-packs.
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Footnotes Across Columns
Another common require-

ment is to span footnotes
across columns. The body text
needs to be in columns, but the
footnotes should span the full
width of the text frame.

It is not difficult to span a
heading across columns as
above, by using two linked text
frames — the top frame has
only one column, while this
text frame has two columns.

Endnotes could also span two
columns in a similar way by placing
them in a separate text frame with
a single column at the end of the
story.i

However, there is no way that
I could find to have endnotes
appear at the foot of the page,
rather than at the foot of the
column in which the note reference
occurs, while keeping automatic
note numbering.ii

i This endnote is placed at the end of the story, so if the end of the story flows into the
final text frame, endnotes will span both columns.
ii Placing endnotes in independent text frames on each page, then inserting the
reference superscripts manually might seem to be OK for half a dozen notes, but it soon
becomes obvious that it is a horrible kludge if notes have to be inserted or deleted later,
or if the text is edited and references move to different pages.

This is even harder to maintain than my kludge for multiple footnotes on a single line.
At least for that one only has to go through adding or removing tabs for the notes that
are moved by adding or removing notes before them.


